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INTRODUCERE - CADRUL GENERAL

Lucrarea de licenta/disertatic reprezinta rezultatul cercetarii stiintifice realizate de absolvent si
trebuie sa probeze rezultate originale in domeniul stiintelor administrative respectiv a stiintelor
juridice.

In conformitate cu Regulamentul de organizare si desfasurare a examenului de absolvire si
Hotararea Senatului Universitatii Ovidius Constanta, examenul de licenta consta din doua probe:
a) evaluarea cunostintelor fundamentale si de specialitate;
b)  prezentarea si sustinerea lucrarii de licenta.
La Specializarea Drept evaluarea cunostintelor fundamentale se realizeaza pe baza unui test grila
din tematica afisata.
La Specializarile din domeniul Stiinte Administrative evaluarea cunostintelor fundamentale se
realizeaza oral din tematica afisata.

Fiecare student al Facultatii de Drept si Stiinte administrative are obligatia de a-si alege
tema lucrarii de licentd/disertatie si cadrul didactic coordonator, respectind, pe parcursul
elaborarii §i prezentarii lucrarii, cerintele impuse de acesta.

Elaborarea lucrarii de licentd/disertatie impune luarea in considerare a urmatoarelor
cerinte:

- domeniul (tema) cercetat(a) sa fie corelat(d) cu specializarea universitara a

absolventului;

- sa asigure absolventului posibilitatea optiunii pentru cercetarea acelui segment de

activitate in care are cele mai profunde cunostinte generale, de specialitate si fata de
care manifesta interes;

Responsabilitatea coordonarii lucrarii de absolvire revine in exclusivitate cadrelor
didactice cu titlul de doctor. In relatia cu studentii Coordonatorul stiintific al lucrarii de
absolvire are urmatoarele obligatii:

- elaboreaza impreuna cu studentul planul lucrarii de licenta;

- consiliaza studentul in cadrul orelor de tutoriat afisate la avizier;

- apreciaza calitatea confinutului capitolelor elaborate si face observatii si sugestii de

completare sau de reconsiderare, acolo unde este cazul,

- analizeaza continutul integral si forma finala a lucrarii;

- intocmeste referatul de apreciere a lucrarii de absolvire in finalul caruia recomanda

sustinerea acesteia in fata comisiei examenului de licentd/disertatie.

Un cadru didactic titular al Facultatii de Drept si Stiinte Administrative nu poate refuza
unui student coordonarea lucrarii de finalizare a studiilor. Cadrele didactice asociate pot
coordona lucridri de finalizare a studiilor numai in co-coordonare cu un cadru didactic titular care
indeplineste criteriile de coordonare. Consiliul Profesoral al Facultatii de Drept si Stiinte
Administrative stabileste numarul maxim de lucrari repartizate spre coordonare unui cadru
didactic. Pentru anul universitar 2015-2016 cadrele didactice pot coordona un numar maxim de
25 de lucrari de absolvire (licenta si disertatie). Temele de absolvire ale fiecarui cadru didactic
impreuna cu orele si locatia pentru tutoriat sunt afisate la avizierele facultatii.

Coordonatorii sunt responsabili pentru:
e temele propuse;
¢ validitatea datelor inscrise in lucrarea de absolvire;
e indrumarea studentilor in realizarea lucrarii,
e cunoasterea §i aplicarea prezentei proceduri;
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e mentinerea nivelului de calitate fixat prin procedura

Studentul/Absolventul are urmatoarele obligatii:

e participa la Intalnirile de tutoriat

e alegerea temei si inscrierea la cadrul didactic coordonator pana la data comunicatd in
momentul afisarii listei temelor pentru

e analizeaza tema lucrdrii de licenta/disertatie pentru care a optat si identificd problemele
principale de solutionat;

e prezinta coordonatorului stiintific proiectul de plan (cuprins) al lucrarii;

e claboreaza, impreuna cu conducatorul stiintific cuprinsul lucrarii.

e respecta problemele inscrise in cuprinsul lucrarii, orice modificare ulterioara a acestuia
fiind facuta cu acordul coordonatorului stiintific.

e solicita consilierea coordonatorului stiintific ori de cate ori apar dificultati in elaborarea
lucrarii;

e prezinta coordonatorului stiintific, la termenele stabilite, partile elaborate din lucrare;

e prezintd lucrarea de absolvire coordonatorului stiintific inainte de copertare, pentru ca
acesta sa aiba posibilitatea sa mai faca observatiile ce impun completari si/sau modificari,

e preda, in termenul stabilit exemplare din lucrarea de absolvire persoanei responsabilid cu
centralizarea acestora.

La nivel de specializare de licenta respectiv de masterat este nominalizatd o persoana
responsabila de coordonarea activitatii de indrumare a lucrarilor de finalizare. Sarcina sa
se rezuma strict la prelucrarea prezentei proceduri cu absolventii si centralizarea studentilor care
au repartizate teme de licenta ori de disertatie. Sarcinile acestui coordonator nu interfereaza sub
nici o forma cu sarcinile coordonatorilor de lucrare, acestia fiind direct implicati si responsabili
de redactarea lucrarii de finalizare a studiilor.

Prezenta Metodologie pentru redactarea si prezentarea lucririi de licenti/disertatie
(numita in continuare Metodologie) este un document adoptat de catre membrii Consiliului
Facultatii de Drept si Stiinte Administrative, avand urmatoarele obiective:

— intelegerea rolului examenului de absolvire si a procedurilor aplicate

— sd-1 sprijine pe studenti 1n eficientizarea muncii lor, in vederea elaborarii si redactarii

lucrarilor

— sa-i sprijine pe coordonatori in indrumarea studentilor si sd eficientizeze activitatile

de coordonare a lucrarilor de absolvire;

— facilitarea redactarii corecte de catre absolvent a lucrarii de absolvire;

— cresterea nivelului calitativ al lucrarilor de absolvire;

— evaluarea unitara a absolventilor care isi sustin lucrarea de absolvire.

Continutul lucrarii de absolvire

Lucrarea de absolvire este organizata pornind de la o ipoteza de cercetare relevanta in
cadrul domeniului disciplinar al stiintelor juridice sau administrative si/sau sa urmareasca
tematici relevante pentru societatea romaneasca contemporand. Lucrarea de licenta ori cea de
disertatie_nu va avea mai mult de 50-60 de pagini.

Dupa stabilirea ipotezei de cercetare, studentul/absolventul trebuie sa stabileasca
subdomeniul, tipul de abordare si metodologia relevantd in cercetare; absolventul trebuie sa
probeze in cadrul lucrdrii buna cunoastere a literaturii de specialitate specifice tematicii si
abordarii alese, precum si cunoasterea celor mai recente evolutii din literatura de specialitate
(reviste academice, carti publicate, date statistice actuale si alte cercetari relevante etc.).




Lucrarea trebuie sa ofere contributii originale de cercetare empirica realizate cu acuratete
metodologica si sd probeze competentele autorului de a explica si interpreta coerent materialul
empiric prin modelul/modelele teoretice alese.

Obiectivul de cercetare asumat de autor este primul si cel mai important element al
lucrarii de absolvire; acesta functioneaza ca prim criteriu pentru evaluarea lucrarii, astfel incat
formularea, justificarea si explicitarea acestuia reprezintd primul pas important in constructia
cercetarii.

Autorul trebuie sa justifice alegerea teoriilor si paradigmelor folosite in functie de
capacitatea acestora de a construi explicatii, predictii etc. asupra subiectului cercetarii. Odata
justificate optiunile teoretice, autorul trebuie sd dovedeascd cunoasterea respectivelor teorii
printr-o trecere in revistd a literaturii de specialitate, cu accent pe stadiul actual al cunoasterii
stiintifice si nu pe caracterul exhaustiv al evolutiilor succesive din interiorul respectivei abordari.

Alegerea si justificarea metodologiei de cercetare trebuie realizata in corelatie logica cu
obiectivul cercetdrii §i cu paradigma teoreticd folositd; autorul trebuie sd justifice alegerea
anumitor metode de cercetare si omiterea altora, si sd probeze utilizarea lor adecvata in
cercetarea empirica.

Gestiunea lucrarii de absolvire se face in doua etape: pana la sustinerea acestora si dupa
sustinere.

Dupa elaborare, candidatul depune lucrarea la conducator, pana la termenul fixat .

Dupa analiza lucrarii si intocmirea referatului, conducatorul vizeaza lucrarea pe care
absolventul o depune la secretarul facultatii, cu cel putin 10 zile inainte de sustinerea lucrarii.
Nedepunerea lucrarii si a documentatiei aferente in termen duce la suspendarea dreptului de
sustinere a lucrarii in sesiunea respectiva.

Secretarul comisiei pentru examenul de finalizare a studiilor si secretarul facultatii
gestioneazi lucrarile pana la sustinere si in perioada sustinerii acestora. In acest interval de timp
lucrarile sunt disponibile pentru a fi consultate de catre membrii comisiei.

Dupa finalizarea examenului, secretarul comisiei preda, pe baza de proces-verbal,
lucrarile la gestionarul acestora din cadrul arhivei Universitatii Ovidius.

in vederea atingerii obiectivelor enuntate anterior, prezenta Metodologie contine:

— informatii referitoare la structura lucrarii de licentd/disertatie;

— reguli de redactare a lucrarii de licenta/disertatie;

— reguli de prezentare a lucrarii de licenta/disertatie;

— grila de evaluare a lucrarii de licenta/disertatie;

— sabloane utilizate pentru redactarea lucrarii de licenta/disertatie.

Prezentul Ghid va fi utilizat ca instrument de lucru al Facultatii de Drept si Stiinte
Administrative incepand cu sesiunea de licenta/disertatie iulie 2016.

Ghidul, impreund cu sabloanele utilizate pentru redactarea lucrarii de licenta, va fi
publicat pe site-ul facultatii si va fi pus in aplicare de catre cadrele didactice coordonatoare si
studenti.



STRUCTURA LUCRARII DE LICENTA/DISERTATIE

Lucrarea de absolvire are doua parti: teoretica si aplicativd. Continutul lucrarii de
absolvire va fi structurat tindnd cont de cele doud parti, avand in componenta
capitole/sectiuni/subsectiuni dar nu mai mult de 4 grade de titluri, fiind incluse urmatoarele
elemente obligatorii:

Coperta — informatiile care trebuie sa apara pe coperta lucrdrii de licentd sunt prezentate in
Anexanr. 1;

Pagina de titlu — informatiile care trebuie sa apara in pagina de titlu a lucrarii de licentd sunt
prezentate Tn Anexa nr. 2;

Cuprins — lucrarea de absolvire va avea un cuprins care sa contind titlurile tuturor
capitolelor/subcapitolelor/sectiunilor/subsectiunilor insotite de numarul paginii la care incepe
fiecare dintre acestea (a se vedea exemplul din Anexa nr. 3);

Introducere — aceasta va contine motivatia alegerii temei, ipoteza ce urmeaza a fi demonstrata,
gradul de noutate a temei, obiectivele generale ale lucrarii, metodologia folosita, precum si
limitele lucrarii. Ea trebuie sa precizeze aspectele care diferentiaza lucrarea de altele existente,
elementele de originalitate, obiectivele lucrarii. In principal, introducerea trebuie sa raspunda
mai multor intrebari:

A. Care este problema studiata?

B. Care sunt ipotezele referitoare la aceasta problema?

C. Ce implicatii teoretice are studiul realizat si cum va influenta el cunoasterea in

domeniu?

D. Care sunt enunturile testate si cum au fost derivate concluziile?

Introducerea nu se numeroteaza ca si capitol;

Partea teoretica prezintd conceptele, teoriile si modelele relevante pe care se fundamenteaza
elaborarea temei In spetd. Se recomandd abordarea comparativa, criticd si nu abordarea strict
descriptiva. Se poate prezenta dezvoltarea istorica/evolutia () problemei. Datele trebuie sa fie
actuale i actualizate. Partea teoretica trebuie sa fie relevantd pentru partea practica, sa reprezinte
suportul acesteia.

Partea de cercetare practica/aplicativa (Studiu de caz, etc.) prezintd contributiile autorului
lucrarii. Contributiile se pot concretiza intr-o cercetare cantitativa sau calitativd empiricd, un
proiect, un studiu de fezabilitate, prezentarea unui model, studiu experimental, studiu de caz si
analiza lui, s.a., In functie de specificul domeniului.

Capitole/subcapitole/Sectiuni/Subsectiuni — lucrarea de absolvire va contine intre 3 si 4
subcomponente numerotate crescator. In cadrul acestora, se vor include 1-2 subcomponente in
care se dezvolta, in urma documentarii, continutul temei din punct de vedere teoretic - in prima
parte - si respectiv al cercetarii aplicative (in care se prezinta metodologia si rezultatele cercetarii
aplicative, solutiile propuse si argumentele autorului). Se recomanda ca cercetarea aplicativa a
lucrarii de absolvire sa aiba ca pondere minim 40% din continut. Fiecare din cele doua parti
(teoretica si practicd) se finalizeaza cu scurte concluzii.
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Concluzii si propuneri — n aceasta parte a lucrarii de absolvire se regasesc cele mai importante
concluzii obtinute n urma cercetarii, opinia personala privind rezultatele obtinute in lucrare,
precum si potentiale directii viitoare legate de tema abordata, modul de valorificare, formularea
unor opinii/observatii asupra aspectelor sesizate In urma evaludrii, studiului sau cercetarii.
Aceasta parte vine sa conchidd fuziunea cercetarii teoretice cu cea aplicativa, indicand
originalitatea, putereca de analiza si sinteza, intr-un cuvant fiind sinteza competentelor pe care
candidatul le-a dobandit in timpul programului de studiu. Concluziile lucrarii nu se numeroteaza
ca si capitol.

Bibliografie —va contine lista tuturor surselor de informatie utilizate de catre absolvent pentru
redactarea lucrarii de licenta. Bibliografia nu se va numerota ca si capitol al lucrarii.

Anexe (daca este cazul) — acestea apar intr-o sectiune separatd, care nu se numeroteaza ca si
capitol. Fiecare anexa se va mentiona cel putin o data in textul lucrarii. Anexele se numeroteaza
crescator (Anexa nr. 1, Anexa nr. 2, etc.).



REGULI DE REDACTARE A LUCRARII DE LICENTA/DISERTATIE

Formatul intregii lucrari este A4, numarul de pagini fiind conform Hotararii Consiliului
Profesoral al Facultatii de Drept si Stiinte Administrative intre 50 si 60 (inclusiv anexele), cu
urmatoarele elemente:

a.

b.

Marginile paginii — se vor utiliza urmatoarele valori pentru marginile paginii (Page
Setup -> Margins):

- stanga: 2,5 cm;

- dreapta: 2 cm;

- sus: 2cm;

- jos:2cm.

Spatiere intre randuri — textul se va tehnoredacta la 1,5 randuri (Format ->
Paragraph -> Line spacing -> 1,5);

Alinierea si fontul titlurilor de capitole si subcapitole (a se vedea anexa nr. 4) —
Titlurile ori capitolele vor fi aliniate utilizdnd optiunea center. Fontul utilizat pentru
redactare va fi Times New Roman, majuscule, bold, cu dimensiunea de 16 puncte,
utilizand diacriticele (a, s, t, 1, 4). Titlul capitolului se va scrie la un rand de capitol
(Capitol -> Enter -> Titlu capitol). Fiecare capitol va incepe pe pagind noua.
Subcapitolele si titlurile acestora se vor scrie la 2 randuri de titlul capitolului
utilizand optiunea justified, indentare de 1,5 cm (Format -> Paragraph -> Indentation
-> Special: First line by 1,5 cm). Fontul utilizat pentru redactare va fi Times New
Roman, Normal, bold, cu dimensiunea de 12 puncte, utilizand diacriticele (&, s, t, 1,
a).

Alinierea si fontul textului in cadrul capitolelor si subcapitolelor (a se vedea Anexa
nr. 4) — textul din cadrul paragrafelor normale (continutul -capitolelor si
subcapitolelor) va fi aliniat utilizdnd optiunea justified. Primul rand al fiecarui
paragraf va avea o indentare de 1,27 cm (Format -> Paragraph -> Indentation ->
Special: First line by 1,27 cm). Fontul utilizat pentru redactare va fi Times New
Roman, single (la un rand), cu dimensiunea de 12 puncte, utilizdnd diacriticele
specifice limbii 1n care este redactata lucrarea (&, s, t, 1, & - pentru limba romana).
Numerotarea paginilor — numerotarea paginilor se face incepand cu pagina de titlu,
pana la ultima pagind a lucrdrii, dar numarul paginii apare doar incepand cu
Introducerea. Numarul de pagina se insereaza in subsolul paginii, centrat (Insert ->
Page Numbers -> Position: Bottom of page (Footer) -> Alignmet: Center).

Tabele — tabelele se numeroteaza cu 2 cifre, prima reprezentand numarul capitolului,
iar cea de a doua reprezentand numarul tabelului din capitolul respectiv. Fiecare tabel
are numar si titlu. Numarul tabelului se mentioneaza deasupra tabelului, aliniat la
marginea din dreapta. Titlul tabelului se mentioneaza la 1 rand de numar, utilizand
optiunea center. Fontul utilizat pentru redactare va fi Times New Roman, bold, cu
dimensiunea de 12 puncte. Daca este cazul, sursa datelor se precizeaza la notele de
subsol.

Figuri — figurile (aici sunt incluse imagini, grafice, capturi de ecran) se numeroteaza
cu 2 cifre, prima reprezentand numarul capitolului, iar cea de a doua fiind numarul
figurii din capitolul respectiv. Fiecare figura are numar si titlu, care se mentioneaza
sub figurd, utilizand optiunea center. Fontul utilizat pentru redactare va fi Times New
Roman, bold, cu dimensiunea de 12 puncte. Daca este cazul, sursa datelor se
precizeaza la notele de subsol.



h. Note de subsol - in situatia in care se citeaza (ex. definitii, puncte de vedere,
clasificari, etc.), se mentioneaza cifre (ex. rata inflatiei, pozitie in clasamente, PIB,
etc.) sau se doreste explicarea unor termeni (ex. stakeholders, formule folosite), se
vor introduce note de subsol (Insert -> Reference -> Footnote -> Location: Footnotes
(Bottom of page) -> Format: Number format (1, 2, 3, ...); Start at: (1) -> Numbering
(Restart each page) pentru a se indica sursa(ele). Fontul utilizat pentru redactare va fi
Times New Roman, single (la un rand), cu dimensiunea de 10 puncte, utilizand
diacriticele. Mentionarea autorilor in textul notei de subsol se va face prin indicarea
prenumelui si a numelui. In cazul citarii unui text mentionat intr-o singura pagini a
lucrarii se va face mentiunea ,,p”; in cazul citarii mai multor pagini din lucrare se va
face mentiunea ,,pp”. Notele de subsol se numeroteaza unitar pentru toata lucrarea, si
vor respecta urmatoarele reguli de citare:

in cazul citarii din carti cu un singur autor: Antonie lorgovan, Tratat de drept
administrativ, vol. 11, editia a IlI-a, Curs universitar, Editura All Beck, Bucuresti,
2001, p. 447

in cazul citarii din carti cu mai multi autori: Corneliu Manda, Cezar Corneliu
Manda, Administratia publica locala din Romdnia, Ed. Lumina Lex, Bucuresti,
1999, p. 27

in cazul citarii din carti cu coordonator: loan Alexandru (coord.), Dreptul
administrativ in Uniunea Europeana, Editura Lumina Lex, Bucuresti, 2007, p. 211
in cazul citarii din carti editate in limba romana dar care au fost traduse din alta
limba: Hesselbein, Frances; Goldsmith, Marshall; Beckhard, Richard -
Organizatia viitorului, traducere, Ed. Teora, Bucuresti, 2000, p. 114

in cazul citarii din articole publicate in reviste: Dacian Dragos, Recursul
administrativ prealabil in dreptul administrativ comunitar in Revista Transilvana
de Stiinte Administrative, nr. 2 (5)/2000

in cazul citarii de articole publicate in volume ale unor manifestari stiingifice:
Baltes Nicolae — in comunicarea Considerente privind organizarea auditului
intern, publicata in Caietul stiintific “Reformele administrative si judiciare in
perspectiva integrarii europene — Sectiunea pentru stiinfe economice si
administrative” nr. 6/2004, Institutul de Stiinte Administrative “Paul Negulescu”,
Ed. BURG, Sibiu, pp. 258-269

in cazul citarii unor repere legislative, in functie de modificarile aduse acestora:
Legea nr. 672 din 19 decembrie 2002 privind auditul public intern, M.Of nr.
953/24.12.2002, cu modificarile si completarile ulterioare / Legea nr. 672 din 19
decembrie 2002 privind auditul public intern, republicata, M.Of nr.
953/24.12.2002, cu modificarile si completarile ulterioare / Legea nr. 672 din 19
decembrie 2002 privind auditul public intern, republicata, M.Of nr.
953/24.12.2002, cu modificarile si completarile ulterioare.

in cazul citarii unor lucrari fara autor: *** — Norme nationale de audit, Ed.
CECCAR, Bucuresti, 1999, p. 65

in cazul citarii unor surse de pe internet se va scrie adresa completa si perioada in
care aceasta a fost accesata: http://www.wall-
street.ro/articol/Companii/149242/cinci-motive-pentru-care-nimeni-nu-vrea-posta-
romana.html#ixzz2vfma5adn accesat la data de 1 iunie 2016

in cazul citarii mai multor lucrari se vor insera atatea note de subsol cate lucrari
sunt citate; numarul notelor de subsol se va separa prin virgula.

Respectarea strictd a metodelor de citare academica are trei ratiuni principale:


http://www.wall-street.ro/articol/Companii/149242/cinci-motive-pentru-care-nimeni-nu-vrea-posta-romana.html#ixzz2VFMA5Adn
http://www.wall-street.ro/articol/Companii/149242/cinci-motive-pentru-care-nimeni-nu-vrea-posta-romana.html#ixzz2VFMA5Adn
http://www.wall-street.ro/articol/Companii/149242/cinci-motive-pentru-care-nimeni-nu-vrea-posta-romana.html#ixzz2VFMA5Adn

e Sa dovedeasca parcurgerea literaturii de specialitate si intelegerea autorilor,
problemelor si dezbaterilor relevante din domeniul, subdomeniul sau paradigma
utilizata.

e Sa distingd cu claritate continutul informational preluat din literatura de
specialitate de contributia originala a autorului (date empirice, idei, argumente,
concepte etc.)

e Sa ghideze cititorii interesati in folosirea materialelor folosite (fie ca e in vederea
aprofundarii cunostintelor acestora, a stimularii dialogului academic cu autorul
tezei sau a continudrii directiei de cercetare a autorului).

Citarea trebuie deci sa fie completd (nu faceti trimiteri la volume intregi fara a preciza
paginile sau macar capitolele la care va referiti) si sa respecte principiul unei singure cautari:
cititorul trebuie sa pardseasca o singurd datd textul pentru a avea informatii complete despre
sursa (evitati formularea op. cit. care obliga la cautarea primei mentionari a sursei respective).

E recomandabil sa alegeti stilul de citare cel mai des folosit in revistele academice din
domeniul de cercetare in care lucrati.

i. Bibliografia - se structureaza pe urmatoarele paliere: ,,Carti, tratate, cursuri,
monografii”, ,,Articole si lucrari conferinte”, ,,Legislatie”, ,,Pagini web”. Aceste liste
bibliografice se vor ordona alfabetic. Pentru carti se va mentiona numele, prenumele
autorului/autorilor, titlul, editura, anul aparitiei, eventual editia, orasul, tara. Toata
bibliografia prezentata trebuie sa se regaseasca in lucrare

Imprimarea tuturor paginilor lucririi se va realiza pe o singura parte a foii.
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REGULI DE PREZENTARE A LUCRARII DE LICENTA/DISERTATIE

Prezentarea lucrarii de absolvire in fata comisiei de examinare este cel putin la fel de
importanta ca si redactarea acesteia. Nota finala obtinuta de catre absolvent este si rezultatul
evaluarii comisiei, in urma prezentarii si sustinerii lucrarii de catre absolvent.

Reguli de prezentare si sustinere a lucrarii de licentd/disertatie:

a. Momentul si locatia prezentarii: absolventii vor fi anuntati asupra datei, orei si
locatiei la care isi vor putea sustine lucrarea in fata comisiei. Neprezentarea
absolventului la data, ora si locatia stabilite poate atrage eliminarea acestuia din
examenul de finalizare a studiilor.

b. Prezentare in PowerPoint. absolventul isi va putea sustine rezultatele cercetarii
realizate cu ajutorul unei prezentari multimedia concepute in PowerPoint sau in orice
alta maniera considera necesar.

c. Timp maxim de prezentare: 10 minute;

d. Intrebari: membrii comisiei pot adresa absolventului oricate intrebari referitoare la
subiectul lucrarii de absolvire si/sau metodologia si resursele folosite; Cadrul didactic
coordonator nu va raspunde Intrebarilor adresate de comisie absolventului.

Recomandari pentru realizarea prezentarii multimedia:

- prezentarea va contine intre 10 si 15 diapozitive (slide-uri);

- existenta obligatoric a unui slide de titlu, care va contine cel putin titlul lucrarii,
numele absolventului si numele cadrului didactic coordonator;

- slide cu cuprinsul lucrarii;

- slide-uri cu text, tabele, figuri cu ajutorul carora se vor prezenta acele aspecte ale
lucrarii ce se doresc a fi comunicate comisiei;

- 1-2 slide-uri pentru concluzii

- slide-urile nu vor contine prea mult text (maximum 7 linii a cate 7 cuvinte fiecare), iar
absolventul nu va citi informatia.

Evaluarea lucrarii de absolvire:

Criteriu general de evaluare Punctaj

1.| Continutul lucrarii/cercetarii intreprinse §i noutatea | 4
temei abordate

2.| Contributii personale 3
3.| Modul de structurare a lucrarii de absolvire 0,5
4.| Modul de redactare a lucrarii 0,5
5.| Prezentarea lucrarii si raspuns la intrebari 2
Criterii complexe Foarte bine Bine Satisfacitor Nesatisfacator
de evaluarea (10-9) (8-7) (6-5) (4-1)
lucrarii de catre
comisie
Gradul corespunderii | Teza corespunde Teza corespunde in | Teza corespunde Teza nu corespunde
tezei specialitatii completamente mare parte partial specialitatii specialitatii solicitate
solicitate specialitatii solicitate | specialitatii solicitate | solicitate
Corespunderea temei | Tema tezei Tema tezei Tema corespunde Tema nu corespunde
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tezei esentei
materialului lucrarii

corespunde esentei
materialului lucrarii
completamente

corespunde esentei
materialului lucrarii
in mare parte

esentei materialului
lucrarii partial

esentei materialului
lucrarii

Actualitatea temei

Tema tezei coreleaza
totalmente cu
cerintele si
necesitatile societatii

Tema tezei coreleaza
in temei cu cerintele
si necesitatile
societatii

Tema tezei coreleaza
partial cu cerintele si
necesitatile societatii

Tema tezei nu
coreleaza cu
cerintele si
necesitatile societatii

Proportionarea
continuturilor tezei

Materialul prezentat
in capitole este total

Materialul prezentat
in capitole este

Materialul prezentat
in capitole este

Materialul prezentat
in capitole este total

echilibrat suficient de partial dezechilibrat | dezechilibrat
echilibrat
Metodologia Metodologia Metodologia Metodologia Metodologia
cercetarii cercetarii este cercetarii este cercetarii este cercetarii este
relevanta adecvata scopului generala, fara neadecvatd
aspecte concrete
Argumentarea §i Argumentare foarte | Argumentare buna Argumentare Argumentare
demonstrarea buna partiala insuficienta

ipotezei/ipotezelor

Procesarea si analiza
teoreticd, implicarea
criticd, interpretativa
a autorului

Procesarea si analiza
teoretica, implicarea
criticd, interpretativa
a autorului este buna

Procesarea si analiza
teoreticd, implicarea
critica, interpretativa
a autorului suficient

de buna

Procesarea si analiza
teoreticd, implicarea
critica, interpretativa
a autorului la
general, fard aspecte
concrete

Procesarea si analiza
teoreticd, implicarea
criticd, interpretativa
a autorului
insuficienta

Noutatea teoretica

Noutatea teoretica
este relevanta

Noutatea teoretica
este expusa suficient
de bine

Noutatea teoretica
este expusa la
general, fard aspecte
concrete

Noutatea teoretica
este expusa
insuficient

Expunerea si
argumentarea
concluziilor

Concluziile sunt
expuse bine

Concluziile sunt
expuse suficient de
bine

Concluziile sunt
expuse la general,
fard aspecte concrete

Concluziile sunt
expuse insuficient

Completitudinea
surselor si a
referintelor
bibliografice

Completitudinea
surselor si a
referintelor
bibliografice este
destul de consistenta

Completitudinea
surselor si a
referintelor
bibliografice este
suficienta

Completitudinea
surselor si a
referintelor
bibliografice este
partiald, lipsesc
unele surse /
referinte de valoare

Completitudinea
surselor si a
referintelor
bibliografice este
insuficienta, lipsa
multor surse/
referinte de valoare

Corectitudinea
stilistica si
gramaticala a

Absolut corect

Corect in temei

Incorectitudini
partiale

Numar mare de
incorectitudini

textului

Corectitudinea Absolut corect Corect in temei Incorectitudini Numér mare de
tehnoredactarii partiale incorectitudini
Perfectarea generala | Conform cerintelor Cu abateri Cu abateri Nu sunt respectate

atezei

regulamentare

nesubstantiale de la
cerintele
regulamentare

substantiale de la
cerintele
regulamentare

cerintele
regulamentare
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ANEXE

In continuare prezentam, fiecare pe cate o pagind, sabloane pentru urmatoarele
documente:

Anexa nr. [: Coperta lucrarii de licenta/disertatie

Anexa nr. 2: Prima pagind a lucrarii de licenta (pagina de titlu)

Anexa nr. 3: Exemplu tehnoredactare cuprins

Anexa nr. 4: Exemplu pentru tehnoredactare bibliografie

Anexa 5 Documentatia depusa odata cu lucrarea
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ANEXA 1A Licenta

Universitatea “Ovidius” din Constanta
Facultatea de Drept si Stiinte administrative
Specializarea: .........ccccoeveviviiieeiie e,

LUCRARE DE LICENTA

Coordonator stiintific:
(TITLUL STIHNTIFIC SINUMELE )

Absolvent:
(NUMELE ABSOLVENTULUI)

Constanta
(Anul)
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ANEXA 1B Disertatie

Universitatea “Ovidius” din Constanta
Facultatea de Drept si Stiinte Administrative
Masterat: ........ccoevviiiiiiiienin,

LUCRARE DE DISERTATIE

Coordonator stiintific:
(TITLUL STHONTIFIC SINUMELE )

Absolvent:
(NUMELE ABSOLVENTULUI)

Constanta
(Anul)
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ANEXA 2
Universitatea “Ovidius” din Constanta
Facultatea de Drept si Stiinte Administrative
Specializarea: .........ccccoeveviviiieiie e,

Titlul lucrarii

Coordonator stiintific:
(TITLUL STHNTIFIC SINUMELE )

Absolvent:
(NUMELE ABSOLVENTULUI)

Constanta

(Anul)
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CUPRINS

Fa) 6 o]0 [U[od=] =TT O RTUTRRPRRRRR

Partea I Cercetare teoretica a fenomenului

I. (Numele sectitnii)..ccccceueeeiiinnnniiiccininnsssnnsseecesssssssssansssecsssns
L1. (Numele SUDSCCLUNTL).......uueeeeeeeeeeeeersssssnneceeiiiiiiiirannnannn
L2. (Numele SUDSECHURNIL).......uuuueeeeeeeeesserssansssiecssssosnsssssssacns

II. (Numele sectitmii).....cceieiiiiiiiimmmnnnniiiii e,
IL 1. (Numele SUDSECHIURIT)...uuueeeeeeeeeeerrrreneeeeeeeesssonnannes

ANEXA 3

IL.2. (Numele subsectiunii)............cccccovveveiieeiieaiesieessasieanens

II1. (Numele sectiunii)...........

LIL 1. (Numele SUDSECLIUNIT).cceeeeeeeeerrreeeeeeeerersnnaneeeeaces

II1.2. (Numele SUDSECLIUNIL)........uunueeeneereeeeesssscsnnsessecessssnnnns

Partea Il Cercetare practic/aplicativa a fenomenului
Metodologia de cercetare

Concluzii (eventual PropuNeri).........ccoceviiiiiniiniieeee e
BiblOgrafie.......c.cov o
Anexe (figuri, tabele, fotografii, tC)........cc.cvvvriiiiiiiiiii
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10.

11.

12.

13.

14.

15.

ANEXA 4
BIBLIOGRAFIE

A. Carti, tratate, cursuri, monografii
Albu, Emanuel; Drept administrativ si stiinta administratiei, partea a ll-a, Editura Fundatia

Romania de Maine, Bucuresti, 2006;

Alexandru, loan (coord.); Drept administrativ european, editia a II-a, Editura Universul
Juridic, Bucuresti, 2010;

Alexandru, loan (coord.); Dreptul administrativ in Uniunea Europeana, Editura Lumina Lex,
Bucuresti, 2007;

Alexandru, loan; Administratia publica — teorii, realitati, perspective, Editia a IV-a, Editura
Lumina Lex, Bucuresti, 2007,

Alexandru, loan; Structuri, mecanisme i institutii administrative, Editura Sylvi, Bucuresti,
1996

Apostol Tofan, Dana; Puterea discretionara si excesul de putere al autoritatilor publice,
Editura All Beck, Bucuresti, 1999;

Apostol Tofan, Dana; Drept administrativ, vol. I, Ed. All Beck, Bucuresti, 2003;

Apostol Tofan, Dana; Drept administrativ, vol. II, Editura All Beck, Bucuresti, 2004.
Apostol Tofan, Dana; Institutii administrative europene , Editura C.H. beck, Bucuresti, 2006.
Canepa, Aristide; Dragos, Dacian, C.; Ranta, Ana Elena; Veliscu, Raluca; Drept
administrativ comparat §i institutii ale Uniunii Europene, suport de curs pentru Universitatea
Babes-Bolyai, Cluj-Napoca, 2010;

Constantinesco, Leontin Jean; Tratat de drept comparat, Vol. Il — Metoda comparativa,
Editura Educational, Bucuresti, 1998;

Cotea, F.; Drept comunitar european; Editura Wolters Kluver, Bucuresti, 2009;

Gheorghe, Filip; Sisteme administrative comparate, Editura Sedcom Libris, Iasi, 2000;
lorgovan , Antonie; Tratat de drept administrativ, vol. I si II, editia a I1I-a, Ed. All Beck,
Bucuresti, 2001;

lonescu, Romulus; Curs de drept administrativ, Editura didactica si pedagogica, Bucuresti,
1970;

B. Articole si lucrari conferinte
Albu, Emanuel; “Recomandarea CM/REC (2007) a comitetului ministrilor din statele

membre ale Consiliului Europei si dreptul la o buna administrare” 1n Revista de Drept

comercial, v. 17, nr. 10 (2007);
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2. Dacian Dragos, Recursul administrativ prealabil in dreptul administrativ comunitar in
Revista Transilvana de Stiinte Administrative, nr. 2 (5)/2000;
3. Scutelnicu, Gina; Controlul exercitat de institutia Avocatului Poporului asupra

administratiei publice romdnesti in Revista Transilvana de Stiinte administrative, nr.

2(5)/2000.

C. Legislatie
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ANEXA 5

DECLARATIE
SUDSEMNALTUT(). ... ettt eane e nree e
fiul Ul e, Sl al v , identificat cu BI/CI
Seria.............. ] S , eliberat de.....ccoveeevieiieeii e , la data
(0 [T L ONP , declar

pe  proprie  raspundere ca lucrarea de licentd/disertatie cu

sub coordonarea StINEIFICA A ......ccoceiiiiiiiiiiiiei i
imi apartine in intregime, cd in elaborarea acesteia nu am folosit alte surse decat
cele mentionate 1n bibliografie si cd am redactat-o respectand intocmai standardele
minime prevazute de regulamentul privind organizarea studiilor de

licentd/disertatie.

Data

Absolvent,
NUME PRENUME
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UNIVERSITATEA “OVIDIUS” CONSTANTA
FACULTATEA DE DREPT SI STIINTE ADMINISTRATIVE
Cerere inscriere la Examenul de Licentd/Disertatie

VIZAT
SECRETAR FACULTATE

SPECIALIZAREA:

DATE PERSONALE ALE CANDIDATULUI
1. Date privind identitatea persoanei

Numele:

Numele anterior:

Prenumele:

2. Genul: FEMININ/MASCULIN

3. Data si locul nasterii:

Ziua/luna / anul / /
Locul (localitate, judet)
4. Prenumele parintilor:

Tata:

Mama:

5. Stare civila: Casatorit(a) Necasatorit(a)

6. Domiciliul permanent: (Str., nr., localitate, judet, cod postal,

Telefon

Email

7. Sunt absolvent(d) promotia: /

8. Forma de invatamant pe care am absolvit-o este:

| Zi/ ID | Cu taxd/ Fara taxa

9. Solicit inscrierea la examenul de licenta:
Sesiunea anul
10. Lucrarea de licenta/disertatie pe care o sustin are urmatorul titlu:

11. Coordonator stiintific:

12. Mentionez ca sustin examenul de licentd/disertatie (pentru prima oara, a doua
oara dupa caz)

DATA SEMNATURA
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EVALUAREA LUCRARII DE LICENTA/DISERTATIE
A
ABSOLVENTULUI/ABSOLVENTEIL........cooiiiiii e

PROMOTIA ...,

1. Titlul lucrarii

........................................................................................................

Coordonator stiintific Prof. / Conf ./ Lect.univ. dr.

2. In calitate de coordonator stiintific al lucrarii consider ca normele de intocmire
si redactare a lucrarii au fost indeplinite si propun lucrarea spre sustinere Comisiei

de Licenta/Disertatie.

Data Semnatura

Coordonator stiintific,
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